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Regulatory Information

1. This is an FCC Class A product. In a domestic environment this product
may cause radio interference in which case the user may be required to
take adequate measures.

This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial
environment. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

2. All contents of this package, including products, packing materials and
documentation comply with ROHS.
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User Notice

All information, documentation, and specifications contained in this manual
are subject to change without prior notification by the manufacturer. The
manufacturer makes no representations or warranties, either expressed or
implied, with respect to the contents hereof and specifically disclaims any
warranties as to merchantability or fitness for any particular purpose. Any of
the manufacturer’s software described in this manual is sold or licensed ‘as
is’. Should the programs prove defective following their purchase, the buyer
(and not the manufacturer, its distributor, or its dealer), assumes the entire
cost of all necessary servicing, repair and any incidental or consequential
damages resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV
interference caused by unauthorized modifications to this device. It is the
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation
of this system if the correct operational voltage setting was not selected prior
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS
CORRECT BEFORE USE.
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Safety Instructions

General

� Read all of these instructions. Save them for future reference.

� Follow all warnings and instructions marked on the device.

� Do not place the device on any unstable surface (cart, stand, table, etc.). If
the device falls, serious damage will result.

� Do not use the device near water.

� Do not place the device near, or over, radiators or heat registers.

� The device cabinet is provided with slots and openings to allow for
adequate ventilation. To ensure reliable operation, and to protect against
overheating, these openings must never be blocked or covered.

� The device should never be placed on a soft surface (bed, sofa, rug, etc.)
as this will block its ventilation openings. Likewise, the device should not
be placed in a built in enclosure unless adequate ventilation has been
provided.

� Never spill liquid of any kind on the device.

� Unplug the device from the wall outlet before cleaning. Do not use liquid
or aerosol cleaners. Use a damp cloth for cleaning.

� The device should be operated from the type of power source indicated on
the marking label. If you are not sure of the type of power available,
consult your dealer or local power company.

� The device is equipped with a 3-wire grounding type plug. This is a safety
feature. If you are unable to insert the plug into the outlet, contact your
electrician to replace your obsolete outlet. Do not attempt to defeat the
purpose of the grounding-type plug. Always follow your local/national
wiring codes.

� Do not allow anything to rest on the power cord or cables. Route the
power cord and cables so that they cannot be stepped on or tripped over.

� If an extension cord is used with this device make sure that the total of the
ampere ratings of all products used on this cord does not exceed the
extension cord ampere rating. Make sure that the total of all products
plugged into the wall outlet does not exceed 15 amperes.
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� To help protect your system from sudden, transient increases and
decreases in electrical power, use a surge suppressor, line conditioner, or
un-interruptible power supply (UPS).

� Position system cables and power cables carefully;  Be sure that nothing
rests on any cables.

� When connecting or disconnecting power to hot-pluggable power
supplies, observe the following guidelines:

� Install the power supply before connecting the power cable to the
power supply.

� Unplug the power cable before removing the power supply.

� If the system has multiple sources of power, disconnect power from
the system by unplugging all power cables from the power supplies.

� Never push objects of any kind into or through cabinet slots. They may
touch dangerous voltage points or short out parts resulting in a risk of fire
or electrical shock.

� Do not attempt to service the device yourself. Refer all servicing to
qualified service personnel.

� If the following conditions occur, unplug the device from the wall outlet
and bring it to qualified service personnel for repair.

� The power cord or plug has become damaged or frayed.

� Liquid has been spilled into the device.

� The device has been exposed to rain or water.

� The device has been dropped, or the cabinet has been damaged.

� The device exhibits a distinct change in performance, indicating a need
for service.

� The device does not operate normally when the operating instructions
are followed.

� Only adjust those controls that are covered in the operating instructions.
Improper adjustment of other controls may result in damage that will
require extensive work by a qualified technician to repair.
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Rack Mounting

� Before working on the rack, make sure that the stabilizers are secured to
the rack, extended to the floor, and that the full weight of the rack rests on
the floor. Install front and side stabilizers on a single rack or front
stabilizers for joined multiple racks before working on the rack.

� Always load the rack from the bottom up, and load the heaviest item in the
rack first.

� Make sure that the rack is level and stable before extending a device from
the rack.

� Use caution when pressing the device rail release latches and sliding a
device into or out of a rack; the slide rails can pinch your fingers.

� After a device is inserted into the rack, carefully extend the rail into a
locking position, and then slide the device into the rack.

� Do not overload the AC supply branch circuit that provides power to the
rack. The total rack load should not exceed 80 percent of the branch
circuit rating.

� Ensure that proper airflow is provided to devices in the rack.

� Do not step on or stand on any device when servicing other devices in a
rack.
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Power Cords

Use the cables supplied with this package. If it becomes necessary to replace
the cables supplied with this package, be sure to use cables of at least the
same standard as the ones provided.

Power Cord:

For models with a 220 - 240 V AC power supply, use a tandem (T blade)
type attachment plug with ground connector power cord that meets the
respective European country’s safety regulations, such as VDE for Germany.
The plug should comply with the VDE 0620 specification; the connector
should comply with the VDE 0625 specification. A minimum 10A, o.75
mm2 x 3G power cord (H05VV-F or VW-1) should be used.

Power Outlet Cords:

For models with a 220 - 240 V AC power supply, the connector should
comply with the VDE 0625 or EN60320 specification. A minimum 10A,
o.75 mm2 x 3G power cord (H05VV-F or VW-1) should be used.
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Package Contents

The complete PN0108 package consists of:

� 1 PN0108 Station

� 1 AC Source Power Cord

� 8 Power Outlet Power Cords

� 8 Safe Shutdown Cables

� 1 PON Cable (DB9 F to DB9 M)

� 1 User Manual*

� 1 Quick start guide

� 1 Mounting Kit :

� Rack mounting brackets and hardware

� 4 foot pads

� 1 Software CD

� 1 Warranty registration card

Check to make sure that all of the components are present and in good order.
If anything is missing, or was damaged in shipping, contact your dealer.

Read this manual thoroughly and follow the installation and operation
procedures carefully to prevent any damage to the switch or to any other
devices on the PN0108 installation.

* Features may have been added to the PN0108 since this manual was
written. Please visit our website to download the latest version of this
manual.

© Copyright 2005 ATEN
®

 International Co., Ltd.
Manual Part No. PAPE-0254-1AXG

Printed in Taiwan 08/2005

ATEN and the ATEN logo are registered trademarks of ATEN International Co., Ltd. All rights reserved.
All other brand names and trademarks are the registered property of their respective owners.
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About This Manual

This User Manual is provided to help you get the most from your PN0108
system. It covers all aspects of installation, configuration and operation. An
overview of the information found in the manual is provided below.

Overview
Chapter 1, Introduction, introduces you to the PN0108 System. Its purpose,
features and benefits are described.

Chapter 2, Hardware Setup, shows the PN0108’s front and rear
components, and provides step-by-step instructions for setting up your
installation.

Chapter 3, Operation, explains the administrative procedures that are
employed to configure the PN0108’s working environment.

Chapter 4, Administration, explains how to connect to the PN0108 as an
administrator; and how to configure the PN0108 for operation.

Chapter 5, Safe Shutdown and Reboot, shows you how to safely close a
system down and reboot it without involving the danger to the file systems that
simply killing the power supply does.

Chapter 6, Upgrading The Firmware, describes how to keep your
PN0108 up to date with the latest features and fixes to its firmware.

An Appendix at the end of the manual provides technical and other important
information regarding the PN0108.
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Conventions

This manual uses the following conventions:

Courier Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means
to press the Enter key. If keys need to be chorded, they
appear together in the same bracket with a plus sign between
them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

� Bullet lists provide information

> Indicates selecting an option on a menu. For example, Start >
Run means to open the Start menu, and then select Run.

Indicates critical information.

Getting Help

For additional help, advice, and information, ALTUSEN provides several
support options. If you need to contact ALTUSEN technical support with a
problem, please have the following information ready beforehand:

� Product model number, serial number, and date of purchase.

� Your computer configuration, including operating system, revision level,
expansion cards, and software.

� Any error messages displayed at the time the error occurred.

� The sequence of operations that led up to the error.

� Any other information you feel may be of help.
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ALTUSEN Information

Technical Support

North America Technical
Phone Support

Registered ALTUSEN product owners are entitled
to telephone technical support. Call the ALTUSEN
Technical Support Center: 949-453-8885.

International Technical
Phone Support

1. Contact your local dealer.
2. Call the ALTUSEN Technical Support Center:

(886-2) 8692-6959.

Email Support Email your questions and concerns to:
support@altusen.com

Online Support
� Troubleshooting
� Documentation
� Software Updates

Online troubleshooting that describes the most
commonly encountered problems and offers
possible solutions to them; online documentation
(including electronically available manuals); and the
latest drivers and firmware for your product are
available at the ALTUSEN website:

http://www.altusen.com

Product Information

For information about all of ALTUSEN’s products and how they can help
you connect without limits, visit ALTUSEN on the web.

ALTUSEN Authorized Resellers

ALTUSEN provides the following ways to find an authorized reseller in your area:

� In the United States of America, call: 866-ALTUSEN (258-8736)

� In Canada and South America, call: 949-453-8885

� In all other locations, call: 886-2-8692-6789

� Visit ALTUSEN on the web at http://www.altusen.com for a list of
locations and telephone numbers
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Chapter 1.

Introduction

Overview

The PN0108 Power Over the NET™  is a control unit that offers remote
power management for up to eight devices (computers, hubs, routers, etc.).
When connected to an ATEN or Altusen TCP/IP accessible module via its
PON (RS232) port - see the diagram below - it allows administrators from
any computer connected to the internet, whether down the hall, or half way
around the world - to control the power off, power on, and reboot status for
each attached device.

PN0108

CN-6000
KN9116
PN9108
SN0108
SN0116

Remote
Administrator

TCP/IP

PON (RS232)
Port
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For flexibility, the PON port can also be used to administer the PN0108
locally via a serial terminal session.

Up to 15 additional PN0108 units can be daisy chained down from the
original unit, providing remote power management for up to 128 devices.
Installation is fast and easy: plugging cables into their appropriate ports and a
simple setup is all that is entailed.

Since the PN0108’s firmware is upgradeable, you can stay current with the
latest functionality improvements simply by downloading firmware updates
from our website as they become available.

With its advanced features and ease of operation, the PN0108 is the most
convenient, most reliable, and most cost effective way to remotely manage
power access for multiple computer installations.

PN0108

Local Terminal
Connection

PON (RS232)
Port
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Features

� Remote power on/off/reboot control for eight outlets via TCP/IP and a
built in RS-232 PON (Power over the Net™ ) port

� Local power on/off/reboot control via the PN0108’s PON port to the
computer’s RS-232 port

� Daisy chain up to 15 additional stations to control up to 128 outlets

� Manual switching between Local and Remote access for each port via
front panel push button switches

� Individual control of each port - users can set the power on sequence and
delay time for each port to allow equipment to be turned on in the proper order

� Easy setup and operation via a GUI interface

� Provides three configuration/management methods: Browser; Telnet; or
Console Terminal

� Safe shutdown and rebooting for Windows systems*

� Overcurrent protection and recovery for each AC port (110 V model
only); total port overcurrent protection (both models) - remote users can
monitor the current status via the GUI interface

� Separate circuits for the unit’s power and the power to the devices - the
power control status menu is still accessible even when an overcurrent
condition trips the devices’ circuit breaker

� On/Off scheduling - allows everything from a one-time start/shutdown, to
daily, weekly, etc. starts/shutdowns at user-specified times

� Port grouping - perform the same action on a specified group of ports

� LEDs for easy status monitoring

� Two level (Administrator and User) security

� Configuration can be reset

� Firmware upgradeable - daisy chained stations receive the upgrade via the
daisy chain bus

* Safe shutdown and rebooting is supported if the Power Monitor utility has
been installed (see Automated Setup, p. 46).
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Requirements

� Browsers accessing the PN0108 must support SSL 128 bit encryption.

� For the Java access, you must have Java J2RE (1.4 or higher) installed on
your computer. Java is available for free download from the Sun Java
website: http://java.sun.com

� For cold booting of attached computers, the computer’s BIOS must
support this feature.

� For Safe Shutdown:

� The computer must be running Windows (Windows 98 or higher).

� The computer’s BIOS must support Safe Shutdown - see Overview, on
p. 45 for detailed information.

� There must be an available COM port on the computer for the Safe
Shutdown cable to plug into.
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Chapter 2.

Hardware Setup

Front View

1. Port LEDs

The Port LEDs provide status information about their corresponding AC
outlet ports. There is one pair of LEDs for each port. The one on the left
is the Remote Access LED; the one on the right is the Power LED:

� A Remote Access LED lights GREEN to indicate that the device attached
to its corresponding port is capable of being controlled remotely.

� A Power LED lights ORANGE to indicate that there is electricity going to
its corresponding outlet. The LED flashes under the following conditions:

� If Modem Ring Resume is enabled (see p. 37), the outlet still
receives electricity even when it is OFF. The Power LED blinks
OFF, then ON for 8 seconds, then repeats this sequence to
indicate this situation.

� When a power status change is pending, the LED flashes until
the change has taken place.

� If both LEDs flash it indicates that there is either an overcurrent situation,
or the relay has failed. See Flashing Lightbulb, p. 18, for more details.

2 4 5 63

1
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2. Firmware Upgrade Switch

During normal operation this switch is in the NORMAL position. The
RECOVER position is used when performing a firmware upgrade. See
Upgrading the Firmware, p. 51, for upgrading details.

3. Power Control Buttons

Each button (A to H), controls the power status of its corresponding AC
output port as follows:

� Pressing the button for less than 3 seconds toggles the port between
Remote Access enabled and Remote Access disabled (Local Mode). If
Remote Access is disabled, the switch does not allow the port to be
managed from a remote connection. (The Remote Access LED is off
when Remote Access Mode has been disabled for its corresponding port.)

� Under Local Mode, pressing and holding the button in for more than 3
seconds switches the power to its corresponding port On or Off.

4. Reset Switch

Pressing and holding this switch in for more than three seconds resets the
PN0108 to its factory default settings. This switch is recessed and must be
pushed with a thin object, such as the end of a paper clip, or a ballpoint pen.

5. Station ID LED

The PN0108’s Station ID displays here. If this is a Single Station
installation (see p. 10), or the First Station on a Daisy Chained installation
(see p. 12), the PN0108 has a Station ID of 01.

6. Power Switch

This standard rocker switch powers the PN0108 On and Off.
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Rear View

1. Power Socket

2. Circuit Breaker

Press to reset the circuit in order to recover from an overcurrent condition.

3. AC Power Outlets

4. Safe Shutdown Ports

Provides safe shutdown and rebooting for Windows 98SE, ME, NT,
2000, XP and Server 2003 systems.

5. PON Output Port

When daisy chaining PN0108 Stations, this is the Chain Out port.

6. PON Input Port

� For a single unit installation, or for the first station of a daisy chained
installation, the PON cable that connects to the CN-6000 (or other
compatible device - see the Overview diagram, p. 1), plugs in here.

� In a daisy chained installation, the PON cable from the Chain Out port
of the parent unit plugs in here.

� When performing a firmware upgrade, the  PON cable that connects
the PN0108 to the computer that will transfer the upgraded firmware
(see p. 51), plugs in here.

6
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Installation

Before you Begin

Stacking

The PN0108 can be placed on any appropriate level surface that can safely
support its weight plus the weight of its attached cables. To place the
PN0108, or to stack units if you are daisy chaining them, remove the backing
material from the bottom of the rubber feet that came with this package, and
stick them onto the switch’s bottom panel at the corners, as shown in the
diagram, below:

Note: To ensure adequate ventilation, allow at least 5.1 cm on each side, and
12.7cm at the back for power cord and cable clearance.

1. Important safety information regarding the placement of this
device is provided on p. iv. Please review it before proceeding.

2. Make sure that power to all the devices you will be connecting
up have been turned off. You must unplug the power cords of
any computers that have the Keyboard Power On function.

3. Make sure that the power supply voltage settings of all the
devices you will be connecting up match the voltage of the AC
source that the PN0108 is plugged into.
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Rack Mounting

The PN0108 can be installed in most standard 19" (1U) racks. To rack mount
the unit do the following:

1. Use the screws supplied with your rack mounting kit to attach the rack
mounting brackets to each side of the device:

Note: The unit can be installed either at the front or the back of the rack.
To install it at the back, simply screw the brackets into the holes at
the rear of the unit.

2. Position the device in the rack and align the holes in the mounting
brackets with the hole in the rack.

3. Screw the mounting brackets to the rack.

Note: Cage nuts are provided for racks that are not prethreaded.

Phillips Hex Head
M3 x 8
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Single Stage Installation

In a Single Stage installation, there are no additional PN0108s daisy chained
down from the first unit. To set up a single stage installation, refer to the
installation diagram below (the numbers in the diagram correspond to the
numbered steps), and do the following:

1. Use the PON cable that was provided with this package to connect the
PN0108’s PON IN port to the CN-6000’s (or other compatible device -
see the Overview diagram, p. 1) PON port.

2. For each device, use one of the AC Outlet power cords supplied with this
package to connect from any available PN0108 output port to the device’s
AC socket. See p. vii for power cord safety information.

3. Safe Shutdown is supported for computers running Windows 98SE, ME,
NT, 2000, XP, and Windows Server 2003.

If you choose to utilize the Safe Shutdown feature (use of this feature is
optional), for each computer use a Safe Shutdown cable to connect from
the PN0108’s Safe Shutdown port to the computer’s serial port.

Note: You must connect the computer to the same letter designation for
both the AC Outlet and Safe Shutdown ports.

4. Use the AC power cord provided with this package to connect the
PN0108’s Power Socket to an AC power source. See p. vii for power cord
safety information.

5. Turn on the PN0108.

6. Turn on the devices.
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Daisy Chaining

To manage even more devices, up to 15 additional PN0108s can be daisy
chained down from the top level unit. Up to 128 devices can be managed on
a complete installation. To set up a daisy chained installation do the
following:

1. For each PN0108 that you add to the chain, use the DB-9 to DB-9 PON
cable that was provided with it to connect the parent PN0108’s PON OUT
port to the child PN0108’s PON IN port.

2. Power up the daisy chained PN0108s in sequence starting with the highest
level parent and working down. In each case, wait for the PN0108’s
Station ID to be ascertained and displayed on the Station ID LED before
powering on the next unit.

The Station ID for First Stage unit is 01; the ID for the Second Stage unit
is 02, etc.

3. After all the PN0108s are up, power on the devices.
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Chapter 3.

Operation

Overview

Depending on your installation’s components, the PN0108 can be accessed in
various ways: via a browser connection to a CN-6000, KN9116, PN9108, or
SN0108/SN0116; or via a terminal connection to a SN0108/SN0116 or a
local console. The sections that follow explain how to connect and operate
the PN0108 with each method.

CN-6000 / KN9116 Browser Operation

Logging In

Remote operation of the PN0108 via a CN-6000 or KN9116 is browser
based. It involves invoking a java program by clicking an icon on the
CN-6000 / KN9116’s web page.

For example purposes, we will access a PN0108 connected to a CN-6000
KVM on the NET™  module.

Note: 1. The browser must support 128 bit SSL encryption.

2. You must have Java 1.4 or higher installed on your computer. Java
is available for free download from the Sun Java website: 
http://java.sun.com

1. In the browser’s URL location bar, specify the IP address of the CN-6000
that the PN0108 you want to access is connected to. (If you don’t know
the IP address, get it from the CN-6000 administrator.)
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2. When the Security Alert dialog box appears, accept the certificate. The
CN-6000 login page appears:

3. Provide a valid Username and Password (set by the CN-6000
administrator), then Click Login to continue.

4. After you have successfully logged in, Click the Power Management icon.
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5. A File Download dialog box comes up asking what you want to do with
the PowerMan.jar file. You can either run it from your browser (click
Open), or save it to disk and run it from your computer. If your browser
permits, run it from your browser.

6. If you save the file and run it from your computer, with your browser still
open, go to the directory where the PowerMan.jar file resides and either
double click its icon, or, from a command window, enter the following
command:

java -jar PowerMan.jar

7. The PN0108 login dialog box comes up:

Provide a valid Username and Password (set by the PN0108
administrator), then Click Login to continue.

Note: If you are the administrator, and are logging in for the first time,
use the default Username: administrator; and the default
Password: password. For security purposes, we strongly
recommend you remove these and give yourself a unique
Username and Password (see p. 35).
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The PN0108 Main Screen

After you have successfully logged in, the PN0108 Main Screen appears:

� When you first start up, the Power Status & Control screen of the First
Station appears in the large central panel. The power management
operations for the devices attached to the Station’s outlets are made here.

� The bar along the left side is used to configure and control each of the
PN0108 Stations on your installation. Regular users manage the devices
they have permission for with the Device Selector and the Status button.
The other buttons in this bar are for the administrator. Administrator
functions are discussed in Chapter 4.
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Device Selector

Since up to 16 PN0108 Stations can be daisy chained, this panel lists each of
the Stations on your installation. The number in
brackets, to the right of the title, indicates the
total number of stations on the installation.

The names of the Stations are listed in the list
box below the title. To select a Station for
power management, click on the arrow to drop the list down; then click to
select the Station you want to work with. When you select a Station, its
Power Status & Control screen displays in the large central panel.

Note: 1. Each PN0108’s Station ID is displayed in the Station ID LED on its
front panel (see p. 6).

2. The outlets in the Power Status & Control screen are only in effect
for the Station that is selected in the Device Selector.

Device Control

With the exception of Status, the buttons in the Device Control panel are
used by the Administrator to configure the power
management options of the Station that is
currently selected in the Device Selector panel.
These functions are explained in Chapter 4.

Clicking the Status button brings up the Power
Status screen for the currently selected device
(see Device Selector, above). The Power Status
Screen is discussed in the next section.
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The Power Status Screen

The Top Panel

Power Sockets:

The top panel of the Power Status screen is divided into eight subareas which
correspond to the A- H outlets on the PN0108’s rear panel.

Each subarea is composed of a socket icon that functions as the Power Button
for its corresponding outlet, and an information panel to its right. Clicking
the socket icon turns the power status of the computer attached to its outlet
On or Off. The icon and the label under it inform you of the power status as
shown in the following table:

Indication Status

Steady Gray Power to the outlet is OFF.

Flashing Gray Power to the outlet is OFF but Modem Ring Resume has been
specified as the remote power option (see Modem Ring
Resume, p. 37, for details).

Flashing Yellow A change in the outlet’s power status is pending. See Modem
Ring Resume and System After AC Back, p. 37 for details.

Steady Amber Power to the outlet is ON.

Flashing Lightbulb Indicates that the outlet is either experiencing an overcurrent
situation, or the relay has failed. Click the icon to recover. If the
port recovers successfully, it returns to the status it was at before
it failed, and the icon changes to reflect the recovered status. If
the port cannot recover, contact Altusen technical support.
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If Reboot is enabled (by putting a check in the checkbox), the computer attached
to the Outlet’s corresponding port will reboot instead of shutting off when the
Power Button is clicked to turn the outlet off. This selection is disabled (grayed
out) if the Outlet isn’t configured for a Safe Shutdown capable option. See
Configuration, p. 36, for further details.

Note: This function only works with computers capable of a Safe Power
Shutdown. See step 3 of Single Stage Installation, p 10, and Safe
Shutdown and Reboot, p. 45.

The Information Panel:

The information panel, just to the right of the socket icon panel, shows the
Outlet’s name and currently selected power option. These parameters are set
by the Administrator with the Configuration function (see p. 36 for details).
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The Bottom Panel

The bottom panel allows you to control the power status of your outlet
groups. 

Outlets can be placed into groups so that Power On/Off actions can be
carried out on the entire outlet group at the same time, rather than performing
the same action on each outlet individually. Clicking the group’s On or Off
Power Button (the rocker switch icons) performs the power action that was
set by the administrator for each of the outlets.

Note: 1. Users must have permission to operate all the ports in a group in
order to use this function. If a user doesn’t have permission to
operate any port in the group, clicking the Power Button has no
effect.

2. If some ports in a group are ON and some are OFF, and you click
the OFF button, the ports that are ON turn OFF. The ports that are
OFF remain OFF. Likewise, if you click the ON button, the ports
that are OFF turn ON, while the ports that are ON remain ON.

Details about creating and configuring power outlet groups are described in
the Configuration section of the Administration chapter (see p. 36).
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PN9108 Browser Operation

Logging In

Remote operation of the PN0108 via a PN9108 is browser based. It involves
logging into the PN9108’s web page, and selecting the PN0108 from the
PN9108’s Device Selector list.

Note: The browser must support 128 bit SSL encryption.

1. In the browser’s URL location bar, specify the IP address of the PN9108
that the PN0108 you want to access is connected to. (If you don’t know
the IP address, get it from the PN9108 administrator.)

2. A Security Alert dialog box appears. Accept the certificate.

3. A login dialog box, like the one below, appears:

4. Provide a valid Username and Password (set by the PN9108
administrator), then Click Login to continue.
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The PN9108 Main Screen

After you have successfully logged in, the PN9108 Main Screen appears:

Select the PN0108 that you want to access from the PN9108’s Device
Selector list.

Operating procedures from this point are the same as the ones described in
the CN-6000 / KN9116 Browser Operation section. Refer to pages 16 - 20,
for details.
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SN0108 / SN0116 Browser Operation

Logging In

Remote operation of the PN0108 via a SN0108 / SN0116 is browser based.
The first step involves logging into the SN0108 / SN0116’s web page, as
follows:

Note: 1. The browser must support 128 bit SSL encryption.

2. You must set the port parameters on the SN0108 / SN0116 port that
the PN0108 connects to as follows: Bps: 384000; Data bits: 8;
Parity: None; Stop bits: 1; Flow control: None.

1. In the browser’s URL location bar, specify the IP address of the SN0108 /
SN0116 that the PN0108 you want to access is connected to. (If you don’t
know the IP address, get it from the SN0108 / SN0116 administrator.)

2. A Security Alert dialog box appears. Accept the certificate.

3. A login dialog box, like the one below, appears:

4. Provide a valid Username and Password (set by the SN0108 / SN0116
administrator), then Click Login to continue.
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The SN0108 / SN0116 Main Screen

After you have successfully logged in, the SN0108 / SN0116 Main Screen
appears:

The PN0108 is accessed through the Telnet function. To continue:
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1. Click the Telnet button to bring up the Telnet Selection screen:

2. Select the port that the PN0108 is connected to.

Note: 1. You must have permission in order to access a port . Port
permission is set by the SN0108 / SN0116 administrator.

2. If you want to view the port history, click the View History
button. A screen showing the Telnet activity that took place on
the device connected to the port appears. Click the browser’s
Back button to return to the Telnet page.
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3. Click Connect.

The SN0108 / SN0116 opens a Telnet session and a screen similar to the
one below appears:

4. Log in with your SN0108 / SN0116 Username and Password. A telnet
connection to the device is established:
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5. At the telnet prompt, key in: ??? to bring up the PN0108’s menu:

Select 1 to switch to the PN0108 configuration and control functions.
These are the text based equivalents of the browser configuration and
control functions. The descriptions and explanations for the Browser
Operations apply to the submenu functions presented here, as well.

Note: 1. As with the browser version, access to many of the submenus
are restricted to the administrator or users with configuration
permission. If you select a submenu that you are not authorized
for, nothing will happen.

2. Some of the submenus do not have an Exit choice. In these cases,
you can return to the previous menu without making any changes
by pressing Enter.

3. You can bring up the Main Menu at any time during your
session.

When you have finished with your session, bring up the Main Menu and
press X to log out.
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Local Console Operation

Local console operation can be accomplished through a VT100 terminal
program, such as Hyperterminal, or with the Java application supplied on the
software CD that came with this package.

Hyperterminal

1. Use the PON cable that came with this package to connect a COM port on
the PC to the PN0108’s RS-232 port. (Refer back to the installation
diagram on p. 11, if necessary.)

2. On your PC, run the HyperTerminal program:

Start → Programs → Accessories → Communications →
Hyper Terminal → Hypertrm.exe

The following dialog box appears:
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3. Key a name to describe the connection in the Name field (we used
Com1Test); select an icon to represent the connection; then click OK.

Note: In the examples that follow we use COM1. If you use a different
COM port, change the settings accordingly.

The following dialog box comes up:

4. For the Connect using: field, select Direct to COM1 (assuming you are
using COM1 on your computer), then click OK. A Port Setting dialog
box similar to the one below comes up:
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5. The PN0108’s serial port settings and the computer’s COM port settings
must be the same. Change the settings in your dialog box (if necessary),
so that they match the PN0108’s COM Port settings, then click OK.

Note: The PN0108’s default settings are 38400 bps; 8 Data bits; No Parity;
1 Stop bit.

6. When the HyperTerminal screen appears, open the File menu and select:

Properties → Settings. The following dialog box displays:

7. Change the settings (if necessary), so that they match the settings shown
in the diagram, then click ASCII Setup... The ASCII Setup dialog box
comes up:
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8. Change the settings (if necessary), so that they match the settings shown
in the diagram, then click OK.

9. Close the HyperTerminal Window. When Windows asks if you want to
disconnect, click Yes. When Windows asks if you want to save the
session, click Yes.

This completes the HyperTerminal setup. For Windows NT, 2000, XP and
Windows Server 2003 systems, a HyperTerminal icon that connects you to
the PN0108 is created on the desktop. For Windows 98 and ME, you must
access HyperTerminal from the Windows Start Menu.

Logging In:

1. Double click the HyperTerminal icon on your desktop.

2. In the VT100 terminal window, key in:

???

A login prompt appears.

3. Key in your Username and Password to bring up the PN0108’s main
menu.
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Java Application

To use this application you must have the Java Runtime Environment (JRE)
version 1.4.0 or higher installed on the computer that connects to the
PN0108. If you don’t already have the proper version of Java installed, go
the the Java Sun website to download and install the latest JRE.

Windows Setup:

This application makes use of several Java COM support files for Windows.
The files can be found on the software CD that came with this package. They
must be copied to the appropriate subdirectories under your JRE directory as
follows:

1. Copy comm.jar to the JRE \lib\ext directory

(e.g., C:\Program Files\Java\j2re1.4.2_06\lib\ext)

2. Copy win32com.dll to the JRE\bin directory

3. Copy javax.comm.properties to the JRE\lib directory

4. Copy the Java Client program (PowerMan.jar) to a convenient location on
your PC.
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Running the Application:

1. Use the PON cable that came with this package to connect a COM port on
the PC to the PN0108’s RS-232 port. (Refer back to the installation
diagram on p. 11, if necessary.)

2. Open a Command Line (DOS) prompt.

3. Change to the directory that PowerMan.jar is located in.

4. Issue the following command:

java -jar powerman.jar

The PN0108 Login dialog box appears:

5. Log in with your username and password.
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Notes:
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Chapter 4.

Administration

System Setup

Clicking the System button brings up the System dialog box:

Administrator

This section sets the administrator’s login name and password. For security
purposes, we strongly recommend you change the default value to something
unique. The minimum number of alphanumeric characters for both entries is
4; the maximum number is 15.

Connection Control

� Session Timeout sets a timeout value. If there is no input from the logged
in operator for the amount of time set with this function, the operator is
automatically logged out and the session is terminated. Valid settings are
from 2 ~ 99 minutes. The default is 3 minutes.

� If No timeout on monitoring is enabled, the system will not time out when
you are using the Monitor function to view the power status of your
installation (see p. 42 for Monitor details).
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Device Control

The Device Control panel allows the PN0108 administrator to configure the
PN0108’s power management parameters. The functions provided by each of
the buttons are explained in the sections that follow.

Note: On multi-station installations, you must perform a separate set up for
each of the Stations.

Configuration

Clicking the Configuration button brings up the Configuration screen:
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Outlet Configuration:

The top panel allows you to set up a power management configuration for
each outlet. These settings determine what takes place when you click the
Power Button On or Off. The meanings of the field headings are given in the
following table:

Heading Meaning

Station Name To make things more convenient on a multi-station
installation, each station can be given a distinctive
name. To name a station key in the name of your
choice - up to 15 letters and numbers.

Outlet Name Each outlet can be given a distinctive name. The
maximum number of characters is 15.

Modem Ring Resume* This is a Safe Shutdown and Reboot option (see p. 45). If
this option is selected, when the Outlet’s Power Button is
clicked OFF, the PN0108 waits for the amount time set in
the Power Off Delay dialog box (see below), and then
performs a Safe Shutdown on the computer attached to
its Outlet. When the Power Button is clicked ON, the
PN0108 waits for the amount time set in the Power On
Delay field (see below), and then restarts the computer.
The front panel LEDs flash while the action is pending.

Note: With this option, although the computer has been
turned off, it is still receiving power through the outlet.
Therefore, the computer can be locally (physically)
turned on or off - in which case the computer’s status
may not correspond with the Outlet Status display. The
gray “socket” icon flashes (instead of remains steady)
to remind you of this. To make sure that the computer
is in sync with the display, click the power On/Off/On
(or Off/On/Off) when making a power status change.

System after AC back* This is a Safe Shutdown option (see p. 45). If this
option is selected, when the Outlet’s Power Button is
clicked OFF, the PN0108 waits for the amount time set
in the Power Off Delay dialog box (see below), and
then performs a Safe Shutdown on the computer
attached to its Outlet.

When the Power Button is clicked ON the PN0108
waits for the amount time set in the Power On Delay
field (see below), and then restarts the computer.

Note: With this option power through the Outlet is cut off.
Although it was safely shutdown, the computer does not
receive any power through the outlet.

2005-09-07

Chapter 4. Administration

37



Heading Meaning

Kill the Power If this option is selected, the PN0108 waits for the
amount time set in the Power Off Delay field (see
below), and then turns the Outlet’s power OFF when its
Power Button is clicked to turn off the power. Turning the
power off performs a cold (non-safe) shutdown. Selecting
this function disables the Reboot checkbox on the main
screen.

Confirmation Required If this option is enabled (there is a check in the
checkbox), a dialog box comes up asking you to
confirm the operation before it is performed. If it is
disabled (there is no check in the checkbox), the
operation is performed without confirmation.

Power On Delay Sets the amount of time the PN0108 waits after the
Power Button is clicked before it turns on the computer
attached to the corresponding outlet.

Power Off Delay Sets the amount of time the PN0108 waits after the
Power Button is clicked before it shuts down the
computer attached to the corresponding outlet.

For the System after AC Back option, after the delay
time expires, the PN0108 waits another fifteen
seconds, then shuts the computer down.

The minimum (and default) delay time is 15 seconds.
The maximum delay time is 999 seconds.

To save your settings, Click Save. To exit without saving your changes, use
your browser’s Back function to go back to the Main web page, or click
another button on the page to go to a different function.

* This function only works with computers capable of a Safe Power
Shutdown. See step 3 of Single Stage Installation, p 10, and Safe
Shutdown and Reboot, p. 45.
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Outlet Groups:

Outlet groups allow power control actions to be carried out on the entire
group at the same time, rather than repeatedly performing the same action on
each individual outlet. You can have four outlet groups per station, and each
group can be given a distinctive name. The maximum number of characters
for the name is 15.

The bottom Configuration panel lets you select the outlets that you want to
put together as an outlet group.

To set up an Outlet Group, give it a Name, then put a check in the boxes of
the outlets you want in the group.

Note: Outlets can belong to more than one group. For example, Group 1 can
consist of outlets A, B, C, and D, while Group 2 consists of outlets B,
D, E, G, and H.

Finishing Up

� When you have finished making your settings selections, click Save to
save your changes.

� To leave this screen after you have saved your changes, click on another
button in the Device Control List.

� To abandon any changes and keep the original settings, click on another
button in the Device Control List without saving this screen.
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Schedule

The Schedule dialog box allows you to set up a scheduled Power On/Off
configuration for each of the outlets. To do so:

1. Select your outlet from the buttons in the upper panel.

2. Put a check in the Enable/Disable checkbox to enable scheduling for the
desired day.

3. Key in the Shutdown and Restart times.

4. Click Save.

5. Repeat for additional outlets.

Finishing Up

� To leave this screen after you have saved your changes, click on another
button in the Device Control List.

� To abandon any changes and keep the original settings, click on another
button in the Device Control List without saving this screen.
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User Management

The User Manager dialog box allows the Administrator to set up Usernames

and Passwords that operators must provide in order to log into the PN0108.
The minimum number of characters for each field is 4; the maximum is 15.

The Administrator also uses this dialog box to set the outlets that a User can
control. A check mark in the box under the Outlet allows a User to control
that Outlet.

Finishing Up

� When you have finished making your settings selections, click Save to
save your changes.

� To leave this screen after you have saved your changes, click on another
button in the Device Control List.

� To abandon any changes and keep the original settings, click on another
button in the Device Control List without saving this screen.
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Monitor

The Device Monitor displays the power status of your entire installation. You
can see at a glance what the On/Off status of each outlet is.

Note: If the No timeout on monitoring function is enabled in the System
dialog box (see p. 35), the PN0108 will not time out when this
function is being used.

To leave this screen, click on another button in the Device Control List.
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Log

The PN0108 maintains a log file of the last 100 events that took place on it.
This dialog box allows you to select the range of events you wish to view:

� Choose Today then click OK to see a listing of only today’s events.

� Choose All then click OK to see a listing of events for the entire log file.

� Choose Selected; key in the desired range of dates in the From and To
fields; then click OK to see a listing of events for a specific time period.

2005-09-07

Chapter 4. Administration

43



Once you make a choice and click OK an Event Log List, similar to the one
below, appears:

When you have finished viewing the event list:

� If you want to return to the Event Log dialog box, click Back.

� If you want to erase the contents of the entire log file, click Clear All.

� To exit, select a different Device Control function.

2005-09-07

PN0108 User Guide

44



Chapter 5.

Safe Shutdown and Reboot

Overview

The PN0108’s Safe Shutdown and Reboot functions are available for systems
running Windows. Safe shutdown and reboot lets you safely close a system
down and reboot it without involving the danger to the file systems that
simply killing the power supply does. In order to use this function:

� You must connect a Safe Shutdown Cable from the PN0108 to the
computer (see Single Stage Installation, p. 10).

� You must enable either Modem Ring Resume or System after AC back (but
not both) in the computer BIOS’ Power Management settings.

Note: 1. The settings you select in the BIOS must match the settings you
made in the Outlet Configuration dialog box (see p. 36).

2. If you choose Modem Ring Resume: 1) your system BIOS must
support this function; and 2) check your computer manual to be
sure the system supports the COM port External Modem Wakeup
function, since some BIOS versions only support this function with
an internal PCI card modem.

If your BIOS doesn’t support the COM port External Modem
Wakeup function, you cannot use Modem Ring Resume.

3. The wording for the Modem Ring Resume function may vary
somewhat from system to system. For example:

� Wake On LAN / Ring Connector

� Modem Ring On

� Power On By External Modem

 In the BIOS settings, choose Enabled.
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4. The wording for the System after AC back function may vary
somewhat from system to system. For example:

� AC Loss Auto Restart

� Restore on AC Power Loss

In the BIOS settings, choose Power On (Full On).
5. NT systems must use the System after AC back function.

Automated Setup

There are two methods to set up safe shutdown and rebooting: Automated,
and Manual. This section discusses an automated setup. Manual setup, is
discussed on page 48. Automated setup is made possible with the use of the
Power Monitor utility supplied on the software CD that came with this
package.

Note: Power Monitor only works with Windows systems.

Power Monitor watches the computer’s power status via the UPS signal. If
the UPS signals a power failure and a low battery condition, a dialog box
pops up to inform you that the utility will perform a safe shutdown in a few
seconds.

Installation

To install the Power Monitor, simply execute the self extracting setup
program (PMonitorSetup.exe). A copy of PMonitor.exe is placed in the
Windows Startup folder so that it executes each time the system is booted.

When monitoring is in effect, a monitoring icon in the form of lightning bolt 
(        ) is placed in the Windows taskbar to indicate so. When monitoring is
temporarily disabled, a canceled lightning bolt icon (          ) is displayed.

� You can switch between enabled and disabled by right clicking the icon
and selecting Start Monitor or Stop Monitor from the pop up context menu.

� You can exit the program by right clicking on the icon and selecting Exit
from the pop up context menu.
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By default, PMonitor monitors the COM1 port. If the utility displays an error
message stating that it is unable to open the COM1 port, it means that the
port is already being used by another utility.

You can either stop the other utility, and try again, or use a different COM
port for the PMonitor program. If you choose to use a different COM port:

1. Stop the PMonitor program

2. Connect your safe shutdown cable to a different COM port

3. Right click on the Monitoring Disabled icon, and select Options from the
context menu that appears. A dialog box, similar to the one below appears:

4. Open the list of COM ports, and select the COM port that the safe
shutdown cable is connected to.

Note: Only changes to the COM port selection can be made in this dialog
box. Since the utility only monitors the Positive UPS signals, the
other settings are fixed.

Uninstalling

To uninstall the utility:

1. Exit the Power Monitor program.

2. Open the Windows Start menu.

3. Choose Programs → Power Monitor → Uninstall Power Monitor.
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Manual Setup

Windows NT, 2000, XP, and Server 2003 can be manually configured for
safe shutdown and rebooting instead of using the Power Monitor utility. The
following sections explain the procedures involved.

Windows 2000 / XP / Server 2003:

To set up Windows 2000, XP, or Server 2003 for safe shutdown and
rebooting, do the following:

1. Go to the Control Panel; open Power Options; open the UPS page; in the
Details panel, click Select. A dialog box similar to the one below appears:

a. For the COM port entry, select the COM port on the computer that the
Safe Shutdown Cable is plugged into.

b. Match the other options to the values shown in the figure above.
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2. Click Next. A dialog box similar to the one below appears:

Select the options in the dialog box so that they match the settings shown
in the figure above.

3. Click Finish; click OK.

To check that the setup is working:

1. Navigate through the following folders: Control Panel → Administrative

Tools → Services.

2. In Services, scroll down until you see the Uninterruptible Power Supply
entry with Started for its status, as shown in the figure below:
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NT:

1.  Go to the Control Panel; open the UPS entry. A dialog box similar to the
one below appears:

a. For the COM port entry, select the COM port on the computer that the
Safe Shutdown Cable is plugged into.

b. Match the other options to the values shown in the figure above.

2. Click OK to finish

To check that the setup is working:

1. Navigate through the following folders: Control Panel → Administrative

Tools → Services.

2. In Services, scroll down until you see the Uninterruptible Power Supply
entry with Started for its status, as shown in the figure below:

2005-09-07

PN0108 User Manual

50



Chapter 6.

Upgrading The Firmware
The Windows-based Firmware Upgrade Utility (FWUpgrade.exe) provides a
smooth, automated process for upgrading the PN0108’s firmware. The
Utility comes as part of a Firmware Upgrade Package that is specific for each
device. New firmware upgrade packages are posted on our web site as they
become available. Check the Altusen web site regularly to find the latest
packages:

Note: If the PN0108 is connected to a PN9108, it is not necessary to
upgrade the firmware directly, since it will automatically receive a
firmware upgrade when the PN9108 is upgraded.

Preparation

1. Go to our Internet support site and choose the model name that relates to
your device (PN0108) to get a list of available Firmware Upgrade
Packages.

2. Choose the Firmware Upgrade Package you want to install (usually the
most recent), and download it to your computer.

3. Use the PON Cable provided with this unit, to connect a COM port on
your computer to the PN0108’s PON In port.
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4. Slide the First Station’s Firmware Upgrade switch to the RECOVER
position.

a. Its Port LEDs blink at half second intervals.

b. The STATION ID LEDs display the word, UP, and blink at half
second intervals.

5. Slide the First Station’s Firmware Upgrade switch back to the NORMAL
position.

a. The First Station’s STATION ID LEDs display the Station ID’s of all
the daisy chained stations in sequence (01, 02, 03...)

b. After the First Station has run through the sequence, its STATION ID
LEDs display the word, UP, and blink at 1 second intervals. Its Port
LEDs also blink at 1 second intervals.

c. Next, all the Port LEDs on the daisy chained stations blink at 1 second
intervals, and their STATION ID LEDs display the word, UP, which
also blinks at 1 second intervals.

d. Finally, all STATION ID LEDs return to displaying their Station ID
numbers, indicating that they are ready for the firmware upgrade
procedure, and you may start the upgrade.

Note: 1. Each station is upgraded in turn. The STATION ID LEDs of
the station currently receiving the upgrade display the word,
UP, and blink at 1 second intervals. All other STATION ID
LEDs display their station numbers, and also blink at 1 second
intervals.

2. All stations restart automatically after they have been
successfully upgraded.
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Starting the Upgrade
To upgrade your firmware:

1. Run the downloaded Firmware Upgrade Package file - either by double
clicking the file icon, or by opening a command line and entering the full
path to it.

The Firmware Upgrade Utility Welcome screen appears:

2. Read and Agree to the License Agreement (enable the I Agree radio
button).
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3. Click Next to continue. The Firmware Upgrade Utility main screen appears.

The Utility inspects your installation. All the devices capable of being
upgraded by the package are listed in the Device List panel.

A blue background behind the device name indicates that itis ready to be
upgraded.

4. After you have made your device selection(s), Click Next to perform the
upgrade.

If you enabled Check Firmware Version, the Utility compares the
device’s firmware level with that of the upgrade files. If it finds that the
device’s version is higher than the upgrade version, it brings up a dialog
box informing you of the situation and gives you the option to Continue
or Cancel.
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If you didn’t enable Check Firmware Version, the Utility installs the
upgrade files without checking whether they are a higher level, or not.

As the Upgrade proceeds status messages appear in the Status Messages
panel, and the progress toward completion is shown on the Progress bar.
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Upgrade Succeeded

After the upgrade has completed, a screen appears to inform you that the
procedure was successful:

Click Finish to close the Firmware Upgrade Utility.

Note: On a daisy chained installation, all stations restart automatically after
they have been successfully upgraded.
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Upgrade Failed

If the upgrade failed to complete successfully a dialog box appears asking if
you want to retry. Click Yes to retry. If you Click No, the Upgrade Failed
screen appears:

Click Cancel to close the Firmware Upgrade Utility. See the next section,
Firmware Upgrade Recovery, for how to proceed.

2005-09-07

Chapter 6. Upgrading The Firmware

57



Firmware Upgrade Recovery

Single Station Recovery

To perform a firmware upgrade recovery, do the following:

1. Power the PN0108 OFF.

2. Slide the Firmware Upgrade switch to the RECOVER position.

3. Power the PN0108 back ON.

4. Repeat the upgrade procedure from the beginning.

5. After the upgrade, power the PN0108 OFF.

6. Slide the Firmware Upgrade switch to the NORMAL position.

7. Power the PN0108 back ON.

Daisy Chained Station Recovery

If any of the Stations on a daisy chained installation fails to complete the
upgrade procedure successfully:

1. Disconnect it from the chain.

2. Connect your computer to its PON In port (with the PON Cable).

3. Perform the upgrade recovery procedure on it as for a single station
recovery.

After the upgrade completes, connect it back into the chain.
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 Appendix

Troubleshooting

Problem 1:

On a safe shutdown and reboot operation, when rebooting, the computer
stops at the logon screen and waits for a Username and Password instead of
automatically logging on.

Solution:

Configure the Autologon function for the computer as follows:

1. For Win NT, run regedit.exe; for Win 2000 or XP, run regedt32

2. Select the following:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\Current Version\Winlogon

3. Under the Edit menu, select Add Value.

4. Add the variables and values as shown in the table below:

Name Value

DefaultDomainName [domain name for this computer]

DefaultUserName [user name for this computer]

DefaultPassword [user password for this computer]

AutoAdminLogon 1

Note: Remove the brackets and replace the text inside the brackets with
suitable values for yourself on this computer.

5. Close the Registry Editor.

Note: Make sure you have a real password (not blank) configured for
logging on to your system.
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Problem 2:

The computer has an older mainboard that doesn’t support APM in the BIOS.
What can I do to get Safe Shutdown and Reboot working?

Solution:

If you are running Windows 2000, XP, or Server 2003, you can do the
following:

1. Open Control Panel → Power Options.

2. Open Properties → APM.

3. Enable Advanced Power Management support.
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Administrator Login Failure

If you are unable to perform an Administrator login (because the Username
and Password information has become corrupted, or you have forgotten it,
for example), you can clear the login information with the following
procedure:

1. Power off the PN0108 and remove its cover.

2. Short the jumper labeled J4.

3. Power on the switch.

4. Wait 5 seconds, then power off the switch.

5. Remove the jumper cap from J4.

6. Close the housing and start the PN0108 back up.

After you start back up, you can use the default Username and Password
to log in (see p. 15 for details).
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Specifications

Function Specification

Power Inlet 1 x IEC 60320/C14 (M)

Power Outlets 8 x IEC 60320/C13 (F)

I/P Rating (Total input) 100 ~ 120V, 50/60Hz, 12A (max)
220 ~ 240V, 50/60Hz, 10A (max)

O/P Rating Per Port 100 ~ 120V, 50/60Hz, 9A (max)
220 ~ 240V, 50/60Hz, 9A (max)

Total 100 ~ 120V, 50/60Hz, 11A (max)
220 ~ 240V, 50/60Hz, 9A (max)

LEDs Outlet Power 8 (orange)

Remote Access 8 (green)

Station ID 2 x 7 segment (yellow)

Connectors PON In2 1 x DB-9 (F)

PON Out 1 x DB-9 (M)

Safe
Shutdown

8 x 6-pin Safe Shutdown Jacks (F)

Switches Power 1 x Rocker

Outlet On / Off
Remote On /
Off

8 x Pushbutton

FW Upgrade 1 x 2 position slide

Reset 1 x Semi hidden

Power
Consumption

No Load 120V; 60Hz; 15W
230V; 50Hz; 15W

Max Load 120V; 60Hz; 1440W
230V; 50Hz; 2300W

Environment Operating Temperature: 0 ~ 40oC
Storage Temperature: -20 ~ 60oC
Humidity: 0 ~ 80% RH Noncondensing

Housing Metal

Weight 3.7 kg

Dimensions (L x W x H) 43.2 x 21 x .4.4 cm
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Limited Warranty
ALTUSEN warrants this product against defects in material or workmanship for a period of one (1)
year from the date of purchase. If this product proves to be defective, contact ALTUSEN’s support
department for repair or replacement of your unit. ALTUSEN will not issue a refund. Return requests
can not be processed without the original proof of purchase.

When returning the product, you must ship the product in its original packaging or packaging that
gives an equal degree of protection. Include your proof of purchase in the packaging and the RMA
number clearly marked on the outside of the package.

This warranty becomes invalid if the factory-supplied serial number has been removed or altered
on the product.

This warranty does not cover cosmetic damage or damage due to acts of God, accident, misuse,
abuse, negligence or modification of any part of the product. This warranty does not cover damage
due to improper operation or maintenance, connection to improper equipment, or attempted repair
by anyone other than ALTUSEN. This warranty does not cover products sold AS IS or WITH
FAULTS.

IN NO EVENT SHALL ALTUSEN’S LIABILITY EXCEED THE PRICE PAID FOR THE
PRODUCT. FURTHER, ALTUSEN SHALL NOT BE RESPONSIBLE FOR DIRECT, INDI-
RECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM
THE USE OF THE PRODUCT, ITS ACCOMPANYING SOFTWARE, OR ITS DOCUMENTA-
TION. ALTUSEN SHALL NOT IN ANY WAY BE RESPONSIBLE FOR, WITHOUT LIMITA-
TION, LOSS OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, DAMAGE OR
REPLACEMENT OF EQUIPMENT OR PROPERTY, AND ANY EXPENSES FROM RECOV-
ERY, PROGRAMMING, AND REPRODUCTION OF ANY PROGRAM OR DATA.

ALTUSEN makes no warranty or representation, expressed, implied, or statutory with respect to its
products, contents or use of this documentation and all accompanying software, and specifically
disclaims its quality, performance, merchantability, or fitness for any particular purpose.

ALTUSEN reserves the right to revise or update its product, software or documentation without
obligation to notify any individual or entity of such revisions, or update.

For details about extended warranties, please contact one of our dedicated
value added resellers.
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Notes:
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